
Release Notes for Curious World Maps  
 
Version 8.2.3 Release  
Issued 4th November 2008 
 
Downloads 
New Features in World Maps 8.2.3 Release  
New Features in previous versions of World Maps  
Known Issues 
Support 
Fixed Problems 

Tutorial Projects and Images 

Tutorial projects and sample images which accompany the Getting Started Guide 
are available from the Curious Software website.  

Click here to download. 

 

Downloads 

    
World Maps 8.2.3 Release 

Crash Offsetting Multiple Keys 

Offsetting multiple keys  would cause crash under some circumstances. This is fixed in 
8.2.3 

Crash Point Path tool 

Adding points with Point Path tool  would cause crash under some circumstances. This 
is fixed in 8.2.3 

Albers Projection 

Albers projection wasn't shown correctly. This is fixed in 8.2.3 

Taiwan Disputed Regions 

Taiwan disputed regions weren't shown correcty. This is fixed in 8.2.3 

BGRenderer 

COM is initialised in Rendering thread so that AVIs can be rendered.  

BGRender can load street data 

World Maps 8.2a Release 

Crash Changing Database 

Changing the loaded database would cause crash under some circumstances. This is 
fixed in 8.2a 

New Features in World Maps 8.2.3 

http://www.curious-software.com/downloads/index.html


World Maps 8.2 Release 

Proxy Server login details (Mac and Windows users) 

Allows Mac users to specify that they should be asked for Proxy Server login details on 
the first internet connection. Previously this had beed a Windows only feature. 

Background Renderer 

Allows projects to be queued for rendering in the background of the same machine. 

Stamp Image on Line shapes 

The Texture tab of the styles editor adds new controls that allows an image to be 
stamped along a line shape, or at the end of a line shape. 

World Maps 8.0b 

HTTP Proxies (Windows only) 

A new toggle in the Proxies page of the Options window allows the user to dynamically 
specify the username and password when using an authenticating proxy server. 

Quick Maps 

A new button (near the World Navigator) can be used to quickly set the end frame for a 
map animation, and add features to the map. 

Pack and Go 

A new option in the File menu allows the project to be saved with an associated 
"Contents" folder that contains any referenced images. 

Performance 

Improvements have been made to the rendering speed of World Maps, particularly for 
multi-processor computers.  

Traffic Travel 

New features are incoporated to support Traffic Travel Time graphics.  

World Maps 7.25 

Find Missing Material 

The new menu item Tools/Find Missing Material can be used to locate images that are 
used by the project, but which are not in their original location. 

New Natural Earth Imagery 

7.25 supports a new Natural Earth option of imagery at 15m/pixel. 



Natural Earth Warnings 

Natural Earth warnings. Instead of warning you at start-up about missing installations 
of Natural Earth there is a button on the Natural Earth tab in the Styles Editor that you 
can use to check the installations and licenses.  

World Maps 7.2 

Virtual Earth 

Support for imagery from Microsoft's Virtual Earth - both as a new Natural Earth option, 
and for Bird's Eye overlays. Click here for an overview and FAQ. 

Intel Mac 

The Curious products now support Intel Macs in native mode. 

World Maps 7.0 

Map Database 

A new release of the built-in map database based on data from Collins Bartholomew. 

Map Projections 

The rectangular map projections (Miller, Mercator etc) now wrap across the 180 
longitude line. 

External Style Sheets 

This new feature allows a Style Sheet to be stored on disk instead of in the project. 
This means that you can have multiple projects that all use the same style sheet. 
Making a change to the style sheet will be reflected in all the projects that use it. 

ense. 

icense. 

To make an External Style Sheet: Export the Style Sheet from the Style Sheet Editor, 
you can choose to link the project's style sheet to the file at this point. 

To use an External Style Sheet: Choose Link from the Style Sheet Editor and specify 
the required Style Sheet. 

Imagery 

Imagery from Airphoto USA can be loaded directly. This is requires an additional 
feature lic

Curious Multi-Resolution (CMR) files can now be compressed (using JPeg 
compression) to provide subtantial savings on disk sizes. 

CMR images can be created from World Maps by rendering multiple tiles. This 
requires an additional feature l

Imagery for the whole world is available at 150m in the new compressed CMR format. 

Imrpoved error reporting from the Imagery on Demand window. 



World Maps 6.2 

Imagery on Demand 

The Imagery On Demand interface is much improved. The user is presented with a list 
of available imagery for the current map, and a slider to specify the required scale. 

90m DEM 

New Curious DEM (relief data) is available for most of the world at 90m resolution 
(compared to the 800m resolution of the built-in data). This new data is supported by 
the 6.2 release. 

Line Spacing in map details 

The line spacingfor map details can be adjusted using the new controls in the Style 
editor's Text tab. 

Traffic Chicklets 

World Maps 6.2a supports Chicklets in Traffic Producer 

World Maps 6.1 

Image Manager 

Available from the Overlays tab, the new Image Manager helps you organise your geo-
referenced imagery so that it is easy to find an image for your map. 

The Image Manager includes a button for "Imagery On Demand" - new licensed option 
that allows you to download geo-referenced satellite images from GlobeXplorer.com 

World Maps 6.0 

Improved Workflow 

World Maps 6.0 utilises a number of caching techniques and support for pre-rendered 
maps to make it faster than ever to get maps to air. 

PreRendered map sequences: To use a pre-rendered map animation - set up your 
map animation as normal and choose Create Pre-Rendered Map Sequence from the 
Layer Menu. Render out the map to a QuickTim movie as normal. In a new project, 
simply load the movie, and World Maps will ask if you want to load it as a map layer. 
Answer yes, and you will have a map layer that has the pre-rendered base map. You 
can add details etc to this base-map just as if it were a dynamically rendered map, but 
you cannot alter the map's view. 

PreRendered still maps: It is also possible to create a pre-rendered still map (using 
Create Pre-Rendered Map Still from the Layer Menu). Using this technique a very high 
resolution map can be output (by specifying a large output size). If you bring this map 
into a new World Maps project you can pan and zoom the view on this base-map much 
more quickly than on a dynamically rendered map. 

Street Data 

NavTeq USA: the newdata supported by World Maps 6.0 is more compact and hence 



it loads faster.  

ever. 

"Locator" Maps 

map.Create 

te inset can then be added to any map 
using the Locator properties for the Map Layer. 

All Caps 

Intersections: the search features now support searching for street intersections. 

Square ends to streets. Using the option in the Options/Preferences window. 

Follow path: text can follow the path of roads - using the check box in the Text tab for 
the style. 

Data: new easier UI to add whole classes of features to the map (e.g. all buildings or 
all roads)  

Tracing: use the Browse Streets to trace a single road. Simply click the start and end 
points (hold down shift to get a popup with more detail). 

Addresses: Enhanced data supports street address numbers (additional license 
required). 

Imagery 

New easy mechanism for adding satellite and ariel imagery to your map. Use the Add 
satellite image button in the Overlays tab. "Imagery on demand" to follow in 6.1 

Improved resolution for very high definition satellite images gives more detail than 

New, quick way to support pre-rendered "insets" showing location of main 
insets using Layer/Create Pre-rendered Map/Locator and put them in the 
SharedData/Locators folder. The appropria

A new check box in the Text tab of the STyle editors allows text to be designated All 
Caps.. 

Symbols 

d commonly used symbols 
to it. These symbols can then be dragged straight to a map. 

3D 

 to use World Maps 
to export a texture. This feature requires a new 3D option license.  

Symbols are a quick and easy way to drag and drop commonly used symbols onto a 
map. Open the Symbols box from the Tools menu, and ad

Create models directly from Curious CMR files removing the need

Access the built-in databases from 3D to allow adding of labels. This feature requires 
the new 3D option license. 

Traffic Export 

 
raffic broadcasts. For more details please contact 

World Maps 6.0 contains support for the new Curious Traffic Producer product. 
Templates for Traffic Producer can be exported from World Maps allowing Traffic
Producer to quickly prepare T



sales@curious-software.com 

    
World Maps 5.5 

General Features 

is a new popup available from the View Menu which displays 
the current tool modifiers. 

aren whole path items have been added to 
the popup menus for the path editing tools. 

 optional feature to allow the combining of multiple 
CMR tiles into one larger CMR. 

Map Data 

r, the Stereographics projections and the new Transverse Mecator projection 
(UTM). 

 previous releases have been addressed, and are detailed in 
Fixed Problems below. 

tailed, data from Planet Observer is now available 
for the Natural Earth topography.  

Keybars and Timeline 

as been added to make it much easier to view the 
timeline at different levels of detail.  

on Curves: animation curves of animated parameters can be displayed and 
edited. 

ng common keyboard modifiers, and dragged independently of the 
unselected keys. 

y/Paste Keys: individual or multiply-selected keys can be cut, copied, and 
pasted. 

y available for shape layers shows keys for all 
shapes and every point in each shape. 

Shapes 

 shape group is equivalent to simply selecting the individual shapes 
which comprise it. 

 
 

New Features in Previous World Maps 

Tool Modifiers: There 

Motion Paths: The smoothing algorithm for motion paths has changed to give 
smoother default motion. Smooth and Sh

Combine CMRs: 5.5j has a new

GeoTiff Export: In 5.5i World Maps supports exporting geo-referenced tiff files as an 
additional option. Note that only some map projections can be used - including Globe, 
Mercato

Map Databases: The latest databases of built-in map data are included with the CD 
installers for this release. As well as general improvements to the map data, a number 
of specific problems with

Natural Earth: Alternative, more de

Keybar Folding: additional folding h

Animati

Select Multiple Keys: a number of keys in a particular bar can be selected 
simultaneously usi

Cut/Cop

Shape Points: a new mini-keybar displa

Shape Grouping: Shapes can be grouped together into a tree hierarchy in Shape 
Layers. Selecting a

Auto Fix Mode: A new toggle in the Shape Animation tabs allows a key to be added to 
every point in a shape, and its transformation, whenever any part of the shape is
edited. This is most useful when roto-scoping as it ensures that changing a shape on a



particular frame fixes the entire shape so that it cannot be altered by changes on any 
other frame. 

an stepping integers, and so provide a much finer grain of control over the 
final shape. 

oints: each point in a shape can be disabled or enabled at any 
frame in an animation. 

on 
oints to shapes ensures that they are added equidistant from 

neighboring points. 

Undo: is now supported while creating new shapes. 

yers allows the smoothing of 
new points in shape motion paths to be turned on or off. 

Display 

e current pixel is now shown beside the cursor 
when the color picker tool is in use. 

displayed, can be toggled without also selecting the layer as the current layer for 

 an improved Aqua user-interface has been 

Rational B-Splines: support for B-splines has been upgraded to support rational B-
splines. These splines have an infinitely varying range of pull values on each vertex, 
rather th

Enable/Disable P

Add Point Tool: holding down a keyboard modifier (by default Ctrl on PC, Option 
Mac) when adding p

Motion Paths: A toggle in the Animation tab for Shape la

Color Picker: color information for th

Layer Eye Toggle: the eye icon on each layer, which determines if a layer is 

editing. 

Improved Interface: on Mac OS X
adopted. 

Working with Image Sequences 

Auto-Adjust Play Range: when loading sequence material it is now possible to 
automatically adjust the time slider range to match the material. 

Photoshop Image Alpha: when loading an image it is now possible to select an Alpha 
Interpretation of "matted on white" which is most suitable for many Photoshop images.

Defau
the pr

lt Filename Format for Rendering: a new option in the Options.. window allows 
eferred filename format for creation of rendered image sequences to be set. 

set button has been added to set kerning back to the default values.

Transform Tool Modifier: keyboard modifiers have been added to the Transform tool 
quick rotation, scaling, or moving of the on a handle. The default 
 are: 

Text 

Text Kerning: a re

Layer Properties 

Transform Reset: a reset button for layer transformations has been added to the 
Layer Properties tab. 

allowing 
modifiers

 pin when not 

Action PC Mac 



Grab pin Alt  Command 
Rotate Alt + Shift Command + Shift 

Scale Alt + Ctrl Command + Option 

Project Management 

Duplicate Layer: 
available in the layers list

a Duplicate Layer option has been added to the pop-up menu 
, for quick copying of an entire layer. 

s 4.5 

n a number of key performance improvements to Curious World Maps 

d shortcut. The modifiers used on all tools can also 

Viewer Pan & Zoom: To activate Viewer Pan & Zoom hold down the Space Bar. Use 
the modifiers de elow for the appropriate action

World Map

Performance 

There have bee
in version 4.5. 

User Interface 

Keyboard shortcuts and tool modifiers: all menu options and switches can now be 
assigned a customizable keyboar
be customized. Key sets can be saved and loaded. The customization dialog can be 
found under View/Options/Keyboard. 

scribed b . 

Action PC Mac 
Pan Drag in viewer Space  Space 
Zoom In 
interactive 

Drag right in
viewer 

 Space + 
Ctrl, Shift or ALT 

Space + 
Option, Shift or Command 

Zoom Out 
interactive 

Drag left in 
viewer 

Space + 
Ctrl, Shift or ALT and 

Space + 
Option, Shift or Comm

Zoom In once  ALT  or Command Click in viewer Space + 
Ctrl or

Space + 
Option

Zoom Out Space + Space + 
once Click in viewer Shift Shift 

Interactive slider update: the project view can now be updated interactively as the 
time slider is moved. Interactive is turned On by default for gFx only installations, and 
Off by default for Curious World Maps installations. The behavior can be changed 
under View/Options/Display/General . If interactive update is switched off by default, 

t 

 playback of either the project view and 

ldable groups of parameters. Opacity values, 
ith sliders can also be set numerically. New multi-turn rotation 
otation parameters. 

it can still be activated by holding down Control or Shift (Windows) or Option or Shif
(Mac) while moving the time slider.  

Bounce and Loop options on playback:
flipbook can now be looped or bounced. 

New user interface model for Properties dialogs: properties dialogs for layers and 
overlays use a new model based on fo
and other values set w
tools are provided for r

Shape Rotoscoping 

Scaling and rotating of selected groups of points: a new "Transform Points" tool is 
provided in all shape editors, allowing multiple points to be shift-selected or control-



selected, and then scaled or rotated about a user-definable pin position. The 
"Transform Points" mode can be temporarily selected from the Shape Points tool by 

 (PC) or option-selected (Mac), either from the screen 
or the menu list. They can then be moved together or scaled or rotated about the pin 

f shape outlines to distinguish shape: each shape 
can now be given its own outline color for editing. Colors can be set directly in the list 

 hold down the Ctrl (PC) or Option (Mac) while 

andles on a Bezier point. 

In the Add Points tool hold down Alt (PC) or Command (Mac) to move an existing 

holding down Ctrl and Alt (PC) or Option and Command (Mac).  

Moving scaling and rotating of selected groups of shapes at one time: all shape 
editors now allow multiple shapes to be moved or scaled at one time. Shapes can be 
shift-selected or control-selected

position of any selected shape. 

User definable color coding o

of shapes displayed in the menu. 

New shape editing modifiers: New tool modifiers are provided to simplify editing 
shapes. 
When creating a BSpline hold down the control key (PC) or Option key (Mac) while 
adding a point to get a sharp point. 
While editing a Bezier or BSpline shape
picking a point, then slide the cursor left to right to set the pull for a BSpline point, or to 
smooth the h
In the Move Points tool hold down Alt (PC) or Command (Mac) to add a point on the 
shape's line 

point. 
All of the above keys can be changed using the Tool Modifiers options menu. 

 
 changed as you type, or segments of the 

item can be selected, and the font changed for that segment only. A shortcut button is 
r 

Move multiple items at once: multiple text items can be selected at once, and moved 

Movement of text items using the page editing tool: a new handle has been added 

 interactive kerning has been added on a character by character level.
 using an on-screen tool. 

t video project sizes: several new project sizes have been added to the 
shortcut list in the Project Settings dialog, including 648x486 Square Pixel NTSC, 

Text 

Mixed fonts, sizes, colors and styles within text items: fonts, and other text 
properties, can now be changed character by character in a text item, rather than 
being applied uniformly to the item. The user interface works in much the same way as
a word processor : the font properties can be

provided to select the whole string. Independent color swatches are now provided fo
the fill color and outline color for characters. 

Multiple text items in text layers: Text layers can now contain multiple text items 
which can be animated independently. 

scaled or rotated together. Text items can be shift-selected or control-selected from the 
list displayed in the menu, or from the screen. 

on the left edge of the text editing tool to allow items to be moved directly within this 
tool, removing the necessity to select the "Move Text" tool for simple moves. 

New text layout tools: new options have been added for laying out multiple text 
items. Items can be aligned vertically or horizontally using their centers or either edge.

Text kerning:full
Kerning can be set visually

Miscellaneous 

New shortcu

640x480 NTSC DV and the standard non-square pixel 720x486 and 720x576 D1 
resolutions.  



Autofit of layer to project and project to layer: new options have been added to 
allow automatic scaling of layers to match the project resolution, and automatic 

atch a layer's size. 

s powerful painting, rotoscoping, 
age manipulation and animation features, to create a complete mapping and image 

 set of improved shape tools. In addition to Bezier shapes, B-Spline 
hapes are now supported, the points of which have individually configurable pull on 

play of shape 
outlines and handles has become highly configurable. Tools are provided for stepping 

Shape editing Tools: these tools, previously found in the toolbar to the left of the 

ext Layers: text benefits from an improved range of rendering styles, including 

equences of Frames: movie layers now support image sequences made up of 

age Layers: an alternative to Movie Layers, always show a single frame rather than 

to 
loop, in which case they start again once the end of the movie has been reached. 

resizing of the project to m

World Maps 4.0  

Curious gFx Option: an optional addition to Curious World Maps, as well as a stand-
alone application in its own right, Curious gFx add
im
creation solution in a single integrated package. 
 
Map Layer Overlays: the Map Layer Contents panel includes a new Overlays panel 
which contains a
s
the shape outline.  
 
Shape Layers: Shape Layers include the additional shape types mentioned above, 
and a range of powerful new tools for manipulating them. New tools include opening 
close shapes, dividing single shapes in two, and joining shapes. Shapes have 
configurable edge softness, editable on a point-by-point basis. The dis

along the timeline to the next or previous shape-related key. 

viewer, can now be found in the Contents tab for Shape and Map layers. 

T
brushed outlines. 
 
S
numbered sequences of individual files, one frame per file.  
 
Im
a sequence. 
 
Looping: control over looping of movie layers has been improved. Movies can au

Alternatively they can be forced to loop over a user-specified number of frames. 

: each layer type has a user-configurable list of filters which can be 
applied in any order to the image. Filters are arranged in a list and can be added, 

k (an eye) allows individual layers to be 
turned on and off. The visibility of a layer affects its appearance both when viewing in 

Options: the layout of the Options... window available from the View... menu has been 

of 
rious World 

aps in an extremely interactive and memory efficient manner. The combining tool 

File Formats: additional file formats are supported, including .iff, .cin, .dpx  

Layer Filters

removed, and re-ordered. 

Layer Display: a new icon in the layer stac

Curious World Maps and when rendering. 

improved.  

World Maps 3.8 

High-Resolution Image Combining Option: an optional feature available on the 
Tools menu which allows combining of multiple image files to make a single, large 
multi-resolution Curious Multi-Resolution file. This is ideal for combining a number 
geo-referenced satellite images into a single file which can be used in Cu
M
also allows for color correction and other adjustments to the source images. 
 



USA Enhanced Topography Option: an optional feature, and the first in a series of 
high resolution terrain (DEM) data sets released by Curious Software to accompany 
Curious World Maps. The data set is a 30m terrain data set covering the USA (60m for 
Alaska), issued in the new easy to use and install CDM format. Data is installed and 

ptions tab contains new settings 
which give an increased level of control over the d

managed from the Import menu. 

Latitude & Longitude Lines: the Styles Editor O
rawing of latitude and longitude 

 

o 
ose 

. Choosing the option to re-scale the 
output image will produce a project sized image that will be re-scaled to the required 

t is 
 

rget. Significant 
improvements have been made to the performance of such scaling in this release, 

fault, is 
located in the software install directory. This location can now be changed from the 

s window, which is available from the View menu.  

deo I/O: support for the Leitch dpsQuattrus video I/O card (PC only) 

  

lines, including the ability to specify custom spacings. 

Scaling in Export Image: a new option has been added to Export Image that allows
the project to be automatically resized to produce high resolution output. If you need to 
produce a very large image at output time, you can choose a smaller project size t
make editing much faster. When you want to output the high resolution version cho
Export Image. From the Export Image window select Frame Size and specify the 
required output size. By choosing the option to re-scale layers, the project will be 
automatically resized to the correct resolution

size - this will result in a lower quality result. 

Texture/Image Scaling in 3D Export: when exporting a 3D model and texture i
common to export the texture at a different frame size from the project frame size in
order to match the capabilities of the 3D system which is the ta

particularly in cases where a project contains multiple layers. 

Settings Directory: Settings files created by Curious World Maps (for example, the 
directory of installed street data) are saved in a Settings directory which, by de

Locations tab of the Option

World Maps 3.67 

Vi

 Known Issues 

Contacting Curious Software Support 
If
contact us at 
 you believe you have found a problem with this release of Curious gFx, please 

 
 the Curious Software website. 

lease visit www.curious-software.com regularly to ensure that you are running the 
latest version. 

Support 

support@curious-software.com to let us know.  
 
Updates to Curious gFx containing minor upgrades and fixes for known problems are
often posted to
P

 

OpenType fonts (Mac 
OSX 10.5 only) 

Composite glyphs would not be rendered correctly from 
some OpenType fonts on Mac. This is fixed in 8.0b - under 
OS X 10.5 (Leopard) only. 

Blocking Video Output When using live video out World Maps would prevent other 
applications from accessing the video device. This is fixed in 
7.25 

GeoTiff Export Whole World unprojected images did not generate correct 
GeoTiff coordinates on export. This is fixed in 7.2e 

Virtual Earth (Intel Mac 
only) 

Virtual Earth did not correctly detect partial tiles on Intel Mac. 
This is fixed in 7.2e 

Producer Output 
Folder 

7.2e includes support for rendering to Producer folders 
without specifying a date/time folder hierarchy. 

Fixed Problems 

mailto:support@curious-software.com


Crash with CMR When using a CMR and blurring the edges there could be a 
crash unders ome circumstances. This is fixed in 7.2e 

Holes in DEM data Holes of "bad" data in high resolution DEM data would 
display bad artefacts where the lower resolution data 
showed through. This is fixed in 7.2e 

Proxy Servers Improved support for systems configured to use Proxy 
Servers 

Texturing (Intel Mac 
only) 

Images used as textures would display incorrectly on Intel 
Mac. This is fixed in 7.2e 

Fixed Help Menu (Intel 
Mac only) 

The Help menu was not displaying correctly on Intel Mac. 
This is fixed in 7.2e 

Crash on start up (Mac 
only) 

On some Mac systems running OS X 10.3.9 the application 
would fail to start up. This is fixed in 7.2d 

DEM files (Intel Mac 
only) 

DEM files did not load correctly on Intel Macs. This is fixed in 
7.2d 

Slow project load If movie files are missing that are referenced in a project, it 
can sometimes take a long time to load the project because 
of network delays while looking for the files. This is improved 
in 7.2d.  

Virtual Earth Fade 
Zones 

Allow the specification of minimum an maximum zoom levels 
so that they are not blended with the next levels of Virtual 
Earth. Use this at the beginning and end of animations 
where there is a dissolve between significantly different 
images in Virtual Earth. 

Proxy Settings Fixed connections via proxy servers. Also allow entry of 
uername and password for Proxy Servers (Windows only). 

Virtual Earth Diagnostics button in the Virtual Earth options page. This 
can be used to check your connection to the Virtual Earth 
servers. 

QuickTime output 
Gamma (Windows 
only) 

On Windows systems QuickTime movies were rendered with 
an incorrect gamma setting which resulted in the colors 
looking washed out. This is fixed in 7.2b. Note that the h.264 
codec still renders incorrectly - this is because of a fault in 
the QuickTime codec. 

Virtual Earth Virtual Earth would not work correctly in conjunction with 
Natural Earth. This is fixed in 7.2a 

Street Browse Tool 
Crash 

The street Browse tool would crash after clicking on the map 
if a cylindrical projection was used. This is fixed in 7.0a 

License Edit (Mac 
Only) 

Clicking the Edit License button was causing a crash on 
some Mac systems. This is fixed in 6.2c 

Imagery on Demand In 6.2c Imagery on Demand attempts to handle errors on the 
server more graciously. 

3D Export In 6.2b the base 3D export license allows export of Curious 
3D format (.c3d) files. 

Locator Maps With some combinations of positions and frames, locator 
maps did not align correctly with the main map. This is fixed 
in 6.2b 

User Labels User added features did not display an "automatic" marker 
correctly. This is fixed in 6.2a 

GeoTiff Export GeoTiff Export did not correctly set the geo-referencing 
information in the output file for certain projections under 
some circumstances. This is fixed in 6.1b 

Hang on start-up (Mac 
only) 

If Natural Earth files were installed but not licensed, the Mac 
version would display a message but then hang on start up. 
This is fixed in 6.1b 

3D Project Settings 
(Mac only) 

Opening the project settings window in 3D Animator would 
cause a crash on Mac. This is fixed in 6.1b 

Crash caused by 
straps 

Some settings of strap styles could caused a crash when off-
screen labels became massively scaled. This is fixed in 6.1b

Browse Tools (Mac The Browse Tools (e.g. Street Browse) did not work correctly 



only) on Mac OS X 10.3. This is fixed in 1.1b 
Crash changing 
projects 

Loading a project that caused the street data to re-load 
would cause a crash under some circumstances. This is 
fixed in 6.1a 

Crash if Locator files 
missing 

Loading a project that used a Locator file that could not be 
found would cause a crash. This is fixed in 6.1 

Loading Producer 
Projects 

Certain projects saved from Producer versions would not 
load correctly back into World Maps. This is fixed in 6.1  

Crash unloading 
Street Data 

Unloading Street Data that was being used by a map detail 
would sometimes cause a crash. This is fixed in 6.1 

Field Rendering when 
using pre-rendered 
maps 

Version 6.1 correctly field renders projects that use pre-
rendered maps. 

3D Export Texture 
misalignment 

The texture and model could be mis-aligned in 3D export. 
This is fixed in 6.0e 

3D Project Controls 
(Mac Only) 

Opening the 3D Project Controls window on Mac caused a 
crash. This is fixed in 6.0d 

Overlay Shapes It was not possible to set the opacity correctly for Map 
Overlay shapes or Satellite overlays. This is fixed in 6.0d 

Out of Memory in 
Local Edition 

Using World Maps Local Edition would cause Out of Memory 
crashes. This is fixed in 6.0d 

Rectangular Locators 6.0d introduces a new setting to draw rectangular region into 
locator images. 

Field Rendering Projects made with 5.5 or earlier would default to the wrong 
field dominance when rendering. This is fixed in 6.0b 

Corruption with CMRs 
(Mac only) 

Some CMRs would show corruption when zoomed in very 
close. This is fixed in 6.0b 

Crash when resizing 
project 

Under some circumstances World Maps would crash when 
resizing a project. This is fixed in 6.0b 

Timecode entry (Mac 
only) 

Some issues with entery in timecode fields have been fixed 
in 6.0b 

Crash loading very 
large jpegs 

Loading a very large jpeg image would sometimes cause a 
crash. This is fixed in 6.0b 

Redraw for 16 bit 
projects 

The viewer would not redraw correctly under some 
circumstances with 16 bit projects. This is fixed in 6.0b 

Hide Imported DEM Selecting the toggle to disable imported DEMs did not cause 
the map to refresh correctly in some circumstances. This is 
fixed in 6.0b 

Play Controls Pressing a key or another control did not correctly stop 
playout under some circumstances. This is fixed in 6.0b 

Textures with RGBA RGBA images used to texture shapes and regions did not 
render correctly. This is fixed in 6.0b 

Text align popup 
menu (Windows only)  

The popup menu for aligning Text items did not work 
correctly in the Windows version of World Maps. This is fixed 
in 6.0b 

Street Data 
Permissions (Mac 
only) 

If a user did not have read access to installed Street Data 
the Street Data Manager Window behaved incorrectly. This 
is fixed in 6.0b 

Negative number for 
Start At (Mac only)  

In the Mac version of Curious World Maps, it was not 
possible to enter a negative number for the "Start At" field for 
Movie layers. This is fixed 6.0b 

 

 


	Word Bookmarks
	five
	gFxPro2.1
	two
	three
	four
	six


